Release Notes
IviumSoft version 2.4XX
Contents
1.
2.
3.

Current Interrupt in ChronoPotentiometry. ......................................................... 2
Voltammetric Pulse Builder ............................................................................... 2
Automatic data storage and file structure ........................................................... 4
3.1
Data file management ............................................................................... 4
3.2
Data file history list ................................................................................... 5
3.3
Data handling options ................................................................................ 6
3.4
Project definition/selection ......................................................................... 8
3.5
Saving Data sets and methods in Projects .................................................... 8
3.6
Data exploring options ............................................................................... 9
4. Corrosion techniques ..................................................................................... 10
4.1
Eoc monitor............................................................................................ 10
4.2
Polarization Resistance ............................................................................ 11
4.3
Tafel Plot ............................................................................................... 11
4.4
Potentiodynamic ..................................................................................... 11
4.5
Cyclic Polarization ................................................................................... 12
4.6
Galvanic Corrosion .................................................................................. 12
4.7
Corrosion Rate Monitor ............................................................................ 13
5. Enhanced AutoCR .......................................................................................... 13
6. Continue Button to proceed to next measurement stage .................................... 14
7. BatchMode with embedded Methods ................................................................ 14
8. Mixed Mode enhancement .............................................................................. 16
9. Mixed mode: Exit scan at threshold ................................................................. 16
10. Mixed Mode: Repeating Sequences and conditional branching ............................. 16
11. Pretreatment before every frequency ............................................................... 17
12. Add timestamp to exported ASCII data ............................................................ 17
13. Monitoring Energy and Charge parameters ....................................................... 17
14. Mixed Mode at Controlled Power ..................................................................... 19
15. Remote driver .dll update and version control ................................................... 19
16. Labeling and Bookmarking Datafiles ................................................................ 20
17. ECN direct transient analysis .......................................................................... 21
18. Prevent IviumSoft from closing while measurement in progress .......................... 22
19. New help file ................................................................................................ 23
20. Hiding noncompliant data in ResultGraph ......................................................... 23
21. ChronoSequencing in BatchMode..................................................................... 24
22. Working with large datafiles ........................................................................... 24
23. Realtime Impedance ...................................................................................... 25
24. ECN: Signal averaging ................................................................................... 25
25. ECN analysis: digital low pass filtering ............................................................. 26
26. Power optimization for active Cells. ................................................................. 26
27. Importing Protocol Templates in Mixed Mode (PITT, GITT) ................................. 27
28. IviFit - IviumSoft Equivalent Circuit Fitting ....................................................... 28
28.1
Increased visual grid ............................................................................ 28
28.2
Improved modelling algorithms ............................................................. 28
28.3
Automatic generation of startvalues ....................................................... 28
28.4
Automatic circuit suggestion .................................................................. 29
28.5
User definable fit boundaries ................................................................. 29
28.6
Graphic selection of fitting range............................................................ 29
28.7
Kramers Kronig test ............................................................................. 29
28.8
Time response reconstruction from the equivalent circuit .......................... 30

Ivium Technologies ©

R2.4XX

1

1.

Current Interrupt in ChronoPotentiometry.

The Current Interrupt Module (CIM) can be used during ChronoPotentiometry. In
Advanced mode, the parameter "CI at Level[2]" was added. When checked, it will
activate a Current Interrupt during the 2nd level.
2.

Voltammetric Pulse Builder

To the group of ElectroAnalysis techniques the
Voltammetric Pulse Builder has been added.
With this technique (new) Voltammetric Pulse
Techniques can be defined to user
specifications. All existing techniques, such as
DPV, NPV, DNPV, SQRWV, etc, can be compiled
with this tool. Moreover newly proposed pulse
waveforms can be constructed and tested, in a
very flexible and user-friendly manner, without
the loss of performance. Pulse patterns can be
defined with 0.02ms resolution, with each pulse
as short as 1ms.

The Voltammetric Pulse Builder implements a Voltammetric scan with the usual
parameters: E_start, E_end, E_step. This will generate a staircase scan, with a pulse
pattern superimposed on each staircase level:
E_end

repeated at
each step

level
4level 2
level 1

level 3

E_step
E_start
Delay time
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Selecting “PulseDefinition” opens a pop-up, in which the pulse pattern can be defined,
for example the pattern above can be achieved with these settings:

Levels:
Delay Time:
E/Volt:
Period/ms:
Add to Result:

the number of Levels (pulses) can be defined (min. 1, max. 4).
wait-time after each staircase level application, before the first pulse is
applied (min. 5ms, max. 5000ms).
pulse height/amplitude (V)
pulse period (ms)
result multiplication-operator

Up to 4 pulse levels can be defined, each between 1ms and 200ms. The total duration of
the 4 combined pulses must be below 600ms (Delay Time not included).
At the end of the “Delay Time”, and at the end of each level, the current is measured.
These recorded values can be used to calculate the single datapoint that is displayed and
stored. The user can define how that datapoint will be calculated, using the “Add to
Result” field in the definition screen. Each level measurement can be
added/subtracted/ignored/etc. in the end-result with multiplication-operators ” +1/1/0/0.5/-0.5”. In the example below, a DPV scan is compiled with 50mV amplitude and
10ms pulse time:

The “+1” operator at Level[1] will add the measured current at Level[1], and the “-1”
operator at Delay Time will subtract the current measured during Delay Time, so the
difference of currents from before and at the end of the pulse will be recorded.
The sampling acquisition period is set automatically equally for all levels to 25% of the
shortest Level Period, maximized to 1 mains line cycle period (50Hz/60Hz option). These
acquisition periods are always located at the end of the corresponding Level.
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Note that the ScanRate is implicitly defined by the “E step” parameters and the sum of
Delay Time and Pulse Periods. In the DPV example above, the total period is 100ms, so
this scan would produce 10 datapoints/second. Suppose Estep was 10mV, the scanrate
would be 100mV/sec.
3.

Automatic data storage and file structure

In IviumSoft versions 2.1XX an important change has been introduced in the way data is
stored and retrieved in the software. This has been done to improve on ease and
accessibility. The most important changes are:
A) All measured data is now automatically stored on disk upon completion of the
experiment. As a result:



The AutoSave method parameter is no longer available. When loading older
methodfiles, the “Automatic save” settings are ignored.
In BatchMode, the automatic data saving is also implemented, which means
that all parameters regarding data saving are also removed here. When
running older batch files, the target data file names and folders are ignored.

B) The new automatic data saving mechanism creates “regular” idf-files that are
readable in the usual manner.
C) The file names and folder locations for auto-saving are automatically created in a
structured manner. In this way saved files are easy to locate and retrieve, and
data can be stored under a project name.
In \:IviumStat a file folder named "data" is automatically created. In this "data"
folder libraries are created, which in turn can contain multiple projects.
\:IviumStat\data
Library 1
Library 2

Project 1
Project 2
|
Project n

Library n

D) Manual saving of data files and data sets remains possible in the usual way.
E) Data files are stored under an automatically generated file name that is
constructed from:
- Scan id; (=automatically incremented scan number)
- Date stamp; (mm,dd)
- Technique used; (for example LSV for Linear Scan Voltammetry)
- First 8 letters (signs) of the Title of the experiment
- Instrument serial number.

3.1

Data file management
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Data will be stored to disk automatically on the following events:



On completion of the datascan (or all datacycles in multiscan run)
When the "timed savings" period expires before the scan finishes, default every
600 minutes:
 The 1st occurrence of an expiry period, the data is saved in .idf
format
 At subsequent occurrences of expiry periods, the data is saved in
CSV format, each time overwriting the previous CSV file.
 After the scan finishes, the complete data is saved in .idf format,
overwriting the 1st saved idf file.



When the total number of datapoints exceeds workfile size, default 400,000
points (user definable, see paragraphs 3.3 Data handling and 22 Working with
large data files):
 When scan exceeds workfile size, an .idf will be stored with present
number of datapoints. Also a CSV file is created with half the
present datasize (200k), and those points are deleted from shown
scan.
 At subsequent occurrences of exceeded workfile size, the 1 st datahalf is saved in CSV format while deleting it from the shown data,
each time appending to the previous CSV file.
 After the scan finishes, the complete data is saved in .idf format,
overwriting the 1st saved idf file. (it uses the CSV file to recover all
datapoints).

Datafiles will be deleted:


3.2

From the “tempfile” folder automatically, after the (user defined) expiry period,
default 90 days (user definable, see 3.3 Data handling).
Manually by the user, by selecting “delete permanently”
Data file history list



Below the Results panel a new Listview panel is visible. This list of files will be
visible in the order that these were recorded or loaded, the most recent file at the
top. These files can be used for quickly switching to earlier results and back. The
Listview panel keeps track of all data stored in the current session; when
(re)starting IviumSoft the most recent 25 stored/called datafiles are listed
(default). Files listed in RED are stored in the 'tempfiles' project and subject to
automatic deletion after a user defined time (see 3.3: Delete temporary files).

Multiple scans/files can be selected simultaneously by holding the [Shift] or [Ctrl]
button and clicking on the desired scans/files
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The history list displays the most relevant scan (method) properties:
Scan id:
automatically generated scan number.
Nscans:
number of scans in the datafile/dataset; datasets are highlighted in
yellow.
Title:
scan title (= method parameter).
Technique: electrochemical technique used to acquire the data in the file.
SN:
serial number of the Ivium instrument used to acquire the data.
Chan:
Ivium-n-Stat channel number (=1 for a single channel instrument).
Cycle:
cycle number for multi cycled experiments (=1 for single cycle).
Status:
results status, 100% = fully completed
File:
file path and name; the file name is automatically generated from
scan id, date (mm,dd), technique and first 8 letters of the title.



A file from the history list can be loaded by double clicking it. Right-clicking it will
allow other options:
Load Scans: will load the selected scan, replacing the previous.
Add Scans: will load the selected scan while retaining the previous.
Copy File:
will place the file on clipboard for copying; paste in MS Explorer will
create a copy of this file in the active folder, paste in an email
program will include the datafile as attachment, etc.
Move to activeproject:
will move the data file from its present location to the active project
location. This could be used to promote temporary files to a
permanent status.
Move to tempfiles:
will move the data file from its present location to the temporary
data folder. This file will be deleted automatically, after the defined
expiry period (see data handling options).
Delete permanently:
will delete the datafile immediately and remove it from the
historylist.



3.3

Older style datafiles (recorded with earlier IviumSoft versions) will appear in this
list when loaded (data unavailable in these datafiles will be displayed arbitrarily).

Data handling options

The data handling options can be accessed from the main menu bar under
Options>Options>Datahandling Options:
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This will open a pop-up that allows setting how
measurement data is stored:
Operator name: the users name may be entered;
this will be stored in the datafile
Library:
name of a group of projects. A
library is a higher folder level,
that can be used to group
projects together. The active
library is used to store new
datafiles; a new one can be
created, or an existing one can
be called from the drop down
menu.
Project:
Folder that contains the datafiles.
the active Project folder is used
to store new datafiles; a new
Project can be created, or an
existing one can be called from
the drop down menu. [see also
3.4].
Timed saving every:
number of minutes before next
automatic data saving will occur.
All data will be saved
automatically upon completion of
the experiment. However, if a
long term experiment is carried
out, the data is also
automatically saved at the end of
every period that is specified
here.
Maximum workfile size:
maximum workfile size before
automatic datastreaming takes
place; default is 400,000 points (min. 2,000; max. 2,000,000, see
paragraphs 3.1 and and 22. Working with large data files).
Maximum in historylist:
number of datafiles listed in history list (for experiments ultimately
resulting in more scans/files than specified here, all scans/files will be
shown in the history list upon completion).
Always createdata CSV file:
when checked, every time a data file (.idf) is saved, a copy of the
primary data is saved as an ASCII file in the same location (this CSV file
will have the same name as the .idf file). The CSV file only contains the
raw data, with comma separated columns (the same as when "copy to
clipboard" is selected from the "Result data" tab). Usually the .csv
extension is registered by MS Excel, and double clicking will open it.
Save multiscan runs in dataset files:
Multiscan experiments can produce multiple cycles after a single click on
"Start". These cycles can be saved in the usual manner with each cycle
in a separate .idf file. However, when this "dataset" option is activated,
such scans are stored together in a single .ids file.
Maximum Nr of visible cycles:
The number specified here is the maximum number of cyles (latest
cycles) that will be shown in the graph during a multi-cycle experiment.
When running a multi-cylce experiment with a large number of cycles
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limiting this number will prevent the graph from becoming
undecipherable.
Maximum Nr of stored cycles:
The number specified here is the maximum number of cyles (latest
cycles) that will be stored in the datafile during a multi-cycle
experiment. When running a multi-cylce experiment with a large
number of cycles limiting this number will prevent the data file from
becoming too large.
Copy data to external folder:
This allows to store copies of the datafiles to other locations, such as
user defined folders, network drives, dropbox, etc. The data is stored
simultaneous with the automatic storage to the project location.
 Save datacopy: when checked, a copy of the data is stored to the user
defined folder. If the destination location is not available, or invalid, the
command is ignored without an error message.
 Redefine filename: normally the filename of the external copy will be
the same as for the automatic generated filename of the project
version. However this behavior can be overridden with this checkbox. If
checked, the user defined filename is used instead. If the user defined
filename already exists, an underscore and (incremented) number is
added to the filename.
Delete temporaryfiles:
The folder "Tempfiles" is normaly used to store files with a temporary
status, such as exploratory measurements. These will automatically be
deleted after the user defined time, default 90 days. Also, there is an
option to "Never" delete automatically.
3.4

Project definition/selection

The Project where newly generated datafiles are stored can also be accessed and/or
changed directly from the top menu bar:

A new Project name can be entered directly, or an existing one can be selected from the
drop down menu. The project name entered here is automatically copied to the
Datahandling options.
For exploratory work, if measurements do not need to be saved for permanent use, you
can, for example, create/select a Draft (project) folder, which can be (manually) deleted
on a regular basis.
3.5

Saving Data sets and methods in Projects

Data Sets
By default data files are saved as .idf. When multiple scans are created in a single
experiment, such as for example when running an number of CV cycles, it is possible to
store these as a dataset in the current project. This can be done from the main menu
bar: File>Save dataset in project.
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In the Data Explorer window data sets are highlighted in yellow.
Methods
A method (technique) with all parameters can be saved as method file (.imf) in a
Project. This can be done from the main menu bar: File>Save method in project. In the
Data Explorer window data sets are highlighted in green.
3.6

Data exploring options

From the top menu bar, a Data explorer can be opened: File>Data explorer.

This will open a Data Explorer window (note that depending on the amount of data, this
may take some seconds):
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The Data Explorer window shows:
 the Library and Project tree to the left
 the list of data files in the selected Project to the right
 when a data file is selected, it will show a preview of the graph and method
parameters below.
The list of data files can show different colors:
 Regular black on white: data file
 Highlighted in yellow: data set
 Highlighted in green: method file
From the Data Explorer window:
 Copy: will put the selected file(s) on the clipboard for copying (to, for example, a
folder or e-mail).
 Delete: will delete the selected file(s) to the trash folder.
 Load File: will load the data file to the primary window.
 Add File: will add the data to the data already present in the primary window.
 Cancel: will close the Data Explorer window.
4. Corrosion techniques
There is a large worldwide market for electrochemical instruments to study corrosion.
Corrosion Scientists can be found in industrial and academic laboratories. After many
years of development, electrochemistry is now considered to be a standard tool in
corrosion laboratories. A group of corrosion techniques has been added:

4.1

Eoc monitor

The Eoc monitor technique will allow the monitoring of the open circuit potential versus
time.
Method parameters:
Title:
Eoc interval:
Run time:
Stop when dE/dt<:

Ivium Technologies ©
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4.2

Polarization Resistance

The Polarization Resistance technique allows a linear potential controlled scan from E
start to E end. The results can be displayed as I/E, E/I, Log(I)/E, E/log(I). The most
common presentation is E (Y-axis) vs. I (X-axis) and is used to measure the corrosion
rate.
Method parameters:
Title:
vs Eoc:
E start:
E end:
E step:
Scanrate:
4.3

scan title
when activated, the E oc will be monitored before the scan is
started and the E parameters can be entered to be relative to E oc.
start potential
end potential
potential step increment
rate of the potential scan

Tafel Plot

The Tafel Plot technique will record a linear potential controlled scan from E start to E
end. The results can be displayed as I/E, E/I, Log(I)/E, E/log(I). The most common
presentation is E (X-axis) vs. log I (Y-axis) and is used to measure the corrosion rate.
The corrosion parameters can be calculated from the Corrosion rate analysis (above the
graph: Analysis>Corrosion rate)
Method parameters:
Title:
vs Eoc:
E start:
E end:
E step:
Scanrate:
4.4

scan title
when activated, the E oc will be monitored before the scan is
started and the E parameters can be entered to be relative to E oc.
start potential
end potential
potential step increment
rate of the potential scan

Potentiodynamic

The Potentiodynamic technique will record a linear potential controlled scan from E start
to E end. The results can be displayed as I/E, E/I, Log(I)/E, E/log(I). The most common
presentation is E (Y-axis) vs. log I (X-axis) and is used to qualitatively evaluate the
corrosion characteristics of the sample.
Method parameters:
Title:
vs Eoc:
E start:
E end:
E step:
Scanrate:
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4.5

Cyclic Polarization

The Cyclic Polarization technique will record a cyclic potential controlled scan from E start
to Vertex 1, and back to E start. The results can be displayed as I/E, E/I, Log(I)/E,
E/log(I). The most common presentation is E (Y-axis) vs. log I (X-axis) and is used to
evaluate the tendency of the sample to undergo localized corrosion. Pitting and crevice
corrosion are the most common examples of localized corrosion.
Method parameters:
Title:
vs Eoc:
E start:
Vertex 1:
I Vertex:
E step:
Scanrate:
4.6

scan title
when activated, the E oc will be monitored before the scan is
started and the E parameters can be entered to be relative to E oc.
start potential
Vertex potential (point at which the scan is reversed)
Vertex current, maximum current allowed before scan direction is
reversed.
potential step increment
rate of the potential scan

Galvanic Corrosion

The Galvanic Corrosion technique will record the current versus time when two different
metals are immersed in an electrolyte. The results can be displayed as E/time and
I/time. In the Galvanic Corrosion experiment, the instrument acts as a Zero Resistance
Ammeter.
The galvanic corrosion technique is implemented for low currents, smaller than and up to
ca. 1mA. If the currents exceed a few mA, this electrode connection cannot be used
anymore and a transient technique needs to be used, like Mixed Mode1.
Electrode connection for Galvanic Corrosion 2:




RE to reference electrode
WE+S to working electrode 1
Gnd to working electrode 2

Method parameters:
Title:
Interval time:
Run time:

scan title
interval time between data points, min. 0.1s; max. 60s.
duration, min. 2s.

1

Note that when using the transient technique, the electrode connection needs to be adjusted to
the 'default' configuration. In Mixed Mode apply 0V to measure galavanic corrosion.
2

Galvanic Corrosion is implemented similar to ElectroChemical Noise, the same electrode
connection applies. See also p. 22/56 of the Manual.
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4.7

Corrosion Rate Monitor

The Corrosion Rate Monitor technique will start with recording the Eoc, after this a Linear
(potential controlled) Polarization Resistance measurement will carried out. This is
repeated for the duration of the experiment and the Rp and corrosion rate are displayed
vs. time. This experiment is commonly used to test the performance of corrosion
inhibitors.
Method parameters:
Title:
Duration:
Repeat interval:
E start:
E end:
E step:
Scanrate:

scan title
experiment duration, min. 2 minutes.
duration of the E oc recording
start potential of the LPR measurement
end potential of the LPR measurement
potential step increment of the LPR measurement
rate of the potential scan of the LPR measurement

5. Enhanced AutoCR
 Pre ranging
It is now possible to let the automatic current ranging start before the measurement
so that the instrument will automatically look for the appropriate Current Range. This
will ensure the measurement starts with an appropriate setting. The pre-ranging can
be switched on/off with the checkbox in the AutoCR subparameter group.

 Pretreatment and Equilibration
The Automatic Current Ranging option is now also activate for the Pretreatment and
Equilibration stages. This will enhance the dynamic measurement range during the
pre-measurement stages.
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6. Continue Button to proceed to next measurement stage
Prior to a (method) measurement, there are several pre-measurement stages:
1.
2.
3.
4.

Purging
Pretreatment
OCP measurement
Equilibration

The duration of these stages is predefined. However now it is possible to manually abort
such stages during its execution, by pressing the "Continue" button. This will stop the
currently running pre-measurement stage, and proceed to the next. If it was the last
scheduled stage, the measurement will start immediately. In case of the OCP
measurement stage, it will accept the last measured value as the actual OCP, and
proceed.
The "Continue" button only appears next to the "Abort" button at the start of a method
and during the pre-measurement stages, at the bottom of the method Tab:

7. BatchMode with embedded Methods
A new function was added to the BatchMode: "DefineMethod":
a.
b.
c.
d.

"DefineMethod" will allow you to define a Method procedure inside the BatchScript.
You can select the Technique and edit measurement parameters directly.
The "DefineMethod" variables are fully embedded in the BatchFile. You do not need
to rely on external method files. When you change the file location, or move to
another pc workstation, you only need to transport the ".ibf" file.
The old "LoadMethod" function is retained, for compatibility reasons. But it is
recommended not use this anymore.
When saving BatchFiles, it is suggested to store these in the active Project folder.
When you select LoadBatch/SaveBatch, the filename selection dialog will start in the
active project folder.
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When DefineMethod is selected, the measurement can be configured in the table below
the BatchScript. Above the property grid, 4 buttons appear:
•

•
•
•

Load: will load (import) the parameters from an existing methodfile on disk. These
are loaded at the moment you press this button, and embedded in the active
BatchFile. If that original sourcefile would be removed/changed afterwards, it
would not affect the embedded Method definitions.
Save: will save (export) the methodparameters to a method "*.imf" diskfile.
Get Active: will copy the parameters from the active Method, as it is displayed on
the main Method tabsheet.
Set Active: will export the DefineMethod parameters to the active Method, and will
be displayed on the main Method tabsheet, replacing the previous active Method.

It is important to note, that while a BatchScript is being edited, the DefineMethod
parameters can be different from the active Method settings on the MethodSheet. Also
note that a BatchScript may contain several different Method definitions. However, when
a Batch is run, and a DefineMethod line is executed, the active Method setting will be set
according to the embedded Method definition on the active line.
Batchfiles (.ibf) can be saved as usual. These must be saved by the user, these are not
saved automatically.
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8. Mixed Mode enhancement
For specific applpications the Mixed Mode technique has been enhanced with additional
method parameters:
Main method parameters:
Continuous AC:

When checked this will maintain the AC amplitude throughout the
Level continuously (otherwise it will be switched off during DC
acquisition).

AC mean current:

This will measure the mean AC current, instead of the DC current,
and plot this in the main dataplot (black line, left axis). The mean
current value is defined by averaging the quadratic current over a
finite number of ac cycles, after subtraction of the dc current.
Please note that the thresholds for currents, are now applicable to
the AC Mean current.

ThresholdHoldoff:

Time that threshold checking is inactive at each level. This
parameter is to be used when, after a levelchange, it is undesirable
that threshold switching happens too fast. It puts a minimum
duration to the level. It is useful when systems need a stabilization
time.
Note 1: the time is always counted from the start of the active
level, so it is "reset" at each level change.
Note 2: the TresholdHoldoff time should not exceed the level
duration.

Level parameters (stages pop-up window):
Define ac:

When checked this will overrule the main method parameters
Frequency and Amplitude. This allows you to select a dedicated
frequency and amplitude for each separate level.

9. Mixed mode: Exit scan at threshold
By default, the thresholds in the Mixed mode level panel will only act within the level. If
a threshold is exceeded, this Level is aborted and the scan continues to the next Level.
Now, an extra option is available: "ExitScanOnThres". If checked and when a threshold is
triggered, it will abort the complete scan.
10.Mixed Mode: Repeating Sequences and conditional branching
Groups of consecutive Levels can be defined as a sequence and repeated multiple times
(Loops). Also, the sequence can be made conditional to definable thresholds.
A sequence can be defined, by checking the "SequenceStart" and "SequenceEnd"
parameters, at the desired Levels. All the enclosed Levels will be part of the sequenceblock. The SequenceStart parameter has a subparameter "SeqRepeatCount" to define
how many times the sequence-block will be executed.

The blocks can be recognized in the Level view, by the opening and closing square
brackets "[ ]" in the properties line, with the repeatcount before the opening bracket.
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The SequenceEnd parameter has a subparameter "SeqExitOnThres" checkbox to leave
the sequence-block when a Threshold value was exceeded. In this way, repeating
sequences can be defined that are aborted by a boundary condition. For example:
cycling charge/discharge of a battery, until the potential exceeds a critical value.

Sequences can be started and ended at each level. The SeqRepeatCount can be defined
from 1-65535. Sequence-blocks can enclose other sequence-blocks (loop nesting), up to
8 levels deep.
11.Pretreatment before every frequency
For the potentiostatic Impedance technique "Constant E", the advanced method
parameter “Pretreat each freq” is added. By checking this option, the pretreatment
sequence is repeated before each new applied frequency.
During each pretreatment, the ac signal is removed, and the dc current is measured
once every second. The (subsequent) pretreatment measurements are recorded and
added to the Pretreatment data.
12.Add timestamp to exported ASCII data
When using "Export Data as ASCII", it is possible to add the time and date of the
measurement. This feature can be activated in the menu Tools>Datahandling options, on
the "Content Tabsheet", by checking "Add timestamp".
When activated, the time and date will be written on the first line of the Exported ASCII
file. The time corresponds with the Starting Time of the scan.
13.Monitoring Energy and Charge parameters
New features have been added to the Mixed Mode technique, that can be used for
example for battery testing. During Mixed Mode experiments, the Charge and Energy
state (for example of a battery) can be monitored against Time or Cycle number. To
access these features click on the Q button to the left of the Result Graph. The second
graph that becomes visible (as before) has now added to it a new bar with labeled
buttons (only in Mixed Mode). To select the display parameter click on the relevant
button:
 Q/t:
Charge vs. time
 C%/t:
(Capacity/Nominal Capacity) * 100% vs. time
 P/t:
Power vs. time
 U/t:
Energy (U) vs. time (integrated P/t plot)
 Q%/cls:
(Q_discharge/Q_charge) * 100% vs. Cycle nr.
 U%/cls:
(U_discharge/U_charge) * 100% vs. Cycle nr.
 C%/cls:
(Capacity_discharge/Nominal Capacity) * 100% vs Cycle nr.
 Uc/cls:
U_charge vs Cycle nr.
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The Nominal (battery) Capacity is a user defined parameter in the method parameter
Data Options/Electrode, in Coulombs. Note that 1mAh=3.6C. The numerical data vs.
time, can be viewed/exported from the Result Data Tabsheet, using the Extended Data
option.
For plots against Cycle nr., it is necessary to have each cycle loaded as individual scan.
Check "Cycle separate" in the method parameters. By default the plots are only updated
after a button on the bar is pressed. Optionally, the plots can be updated automatically
in rea ltime while a scan is in progress, by checking "Automatic charge calc." in the
menu "Options/Settings".
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14.Mixed Mode at Controlled Power
In the Mixed Mode technique an extra control mode has been added. Next to controlled
E/I/OpenCell/Z in Mixed Mode, also the applied Power can be controlled: P Control. The
Power is defined in Watt, and is calculated from the product of the (S-RE)-voltage and
the WE-Current.

A positive applied power means that the instrument will apply a positive current, and a
negative applied power will generate negative current. Note that the potential can be
positive or negative in either of the latter cases; the sign of the "real power by the cell"
depends on the object. For example for an active object, such as a battery, a positive
applied power means that the battery is being charged by the Energy of the instrument,
while for a negative applied power Energy will be drained from the battery, but the
battery voltage in both these cases is "positive".
In "P control" mode, the instrument uses a fixed Current Range. AutoCR cannot be used.
For the best performance, it is advisable to select the best initial Current Range and
Potential Range.
15.Remote driver .dll update and version control
The IVIUM_remdriver.dll has been updated to version 3.
The version can be read by the calling program with the
"IV_version" function that can be imported from the .dll. It
returns an 32bit integer with the version number.
The required IVIUM_remdriver version for IviumSoft can be
verified in the top menu option "About". Clicking on this will
open a pop-up window. At the bottom left the IviumSoft
release version is given, behind it between brackets [..] the
IVIUM_remdriver.dll version it corresponds with.
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16.Labeling and Bookmarking Datafiles
Datafiles can be labeled with a description and/or bookmarked for convenient recognition
and later retrieval. Directly above the file history list, a field is available where the
"Description" of the selected scan can be entered. The new description can be stored in
the datafile by pressing the Apply button.

This description will appear in the 3rd column of the filelist. The description text can be
of unlimited length.
Datafiles of special importance can be bookmarked, by checking the Bookmark box and
subsequently clicking "Apply" (unchecking the button and clicking "Apply" will remove
the Bookmark. Bookmarked files can be recognized by the underlining in the file history
list. Directly to the left of the file history list, there are 2 buttons:
[Files]
[Bmrks]

shows the usual historylist of datafiles
brings up the list of bookmarked files.
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Bookmarks can also be set/removed by right-clicking on a datafile in the Historylist or
Bookmarklist, and selecting the appropriate item form the popup menu.
In the Data Explorer, bookmarks can also be created. A list of all bookmarks files can be
shown by selecting the "Bookmarks" branch in the root of the Projects tree (on top).

17. ECN direct transient analysis
In addition to the possibility to analyze ElectroChemical Noise (ECN) data in the
frequency domain (Fourier, MEMS, etc.), now the time domain transients can be
evaluated directly.
On the "Time domain analysis" tabsheet of the Electrochemical Noise Analysis tool, both
the E and I data can be analyzed, in segments over time: the full length of the ECN E or
I data is divided into segments of user defined duration, to which the selected analysis is
applied. The segment-results are plotted vs. time.
Several analysis are available:







Inoise Std.dev:
Enoise Std.dev:
Rp:
Pitting index:
E transients:
I transients:

standard deviation of the current signal
standard deviation of the potential signal
Enoise Std.dev / Inoise Std.dev
Inoise Std.dev / mean current
number of E transients* in each segment.
number of I transients* in each segment.

*A transient (or peak) is counted when its absolute difference from the "average
segment value" exceeds the defined threshold. Note that consecutive points that
exceed the threshold do not increase the transient (or peak)-count. These are
assumed to belong to the same transient.
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The selected time analysis is performed by clicking the "calculate" button. The results
are shown in the graph, which can be copied by right-clicking on the plot and selecting
"Copy". The numerical results can be copied with the "Copy data" button, and can be
pasted into other applications (Excel, etc.) in the usual manner.
18. Prevent IviumSoft from closing while measurement in progress
If the IviumSoft application is closed, active/running measurements are aborted and the
data is lost. When the user attempts to close the application while a measurement is in
progress, a message will popup:

Responding with "OK" will close IviumSoft and the data is lost. Selecting "Cancel" will
ignore the attempt to close Iviumsoft and continue the measurement. Note that the
popup will wait for a response while the measurement continues. A response is needed
before IviumSoft can accept new commands or settings.
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19. New help file
IviumSoft is equipped with a 'help' function that is content sensitive: this means that
placing your cursor or making a selection and pressing [F1] will automatically open the
help file on the subject that is selected.
Starting at IviumSoft version 2.301 the help file is based on and compiled in .html. This
means that if you have an existing IviumSoft installation the old help file does not work
anymore and the new .html help file needs to be installed (instructions, see below).
The new .html help is expanded to include the complete manual. Next to the content
sensitive help, of course the help file can also be opened from the top menu bar. In this
case the complete contents of the help/manual are displayed by subject in logical order.
The help/manual can be searched for example by subject or keyword.
Future releases of IviumSoft, when relevant, will also include a new help file. New
features of the new IviumSoft release are included in that new help file.
Installing the new help file
New installation:

The newest help file will be automatically installed when first
installing IviumSoft from the installation CD on a PC.

IviumSoft update:

When IviumSoft is updated from our webpage at
www.ivium.com/support, a new helpfile (IviumSoft.chm) is included
in the zipfile and should be copied together with the IviumSoft.exe
to your IviumStat file directory.

20. Hiding noncompliant data in ResultGraph
Previously all loaded and/or generated data would be visible in the ResultGraph, i.e.
when an LSV was executed after an impedance (EIS) experiment without deleting the
EIS data, the LSV data would be plotted in the EIS graph. This would cause the
data/graph to look erratic.
Now, only data will be displayed that is compliant with the active plot. So in the previous
example, the EIS data would be hidden from view after the LSV started. Note that the
EIS data is still there. If thereafter another EIS experiment would be run, the older EIS
data would become visible again (and the LSV data will become hidden).
The display mode always follows the active scan. Previous recorded/loaded scans will
only be visible when these are compliant with the current display mode. Note that this
will make it now possible to meaningfully combine results from different techniques in 1
dataset.
When multiple scans are loaded, containing data recorded with different techniques, the
hidden ones can be viewed by mouseclick, while keeping CTRL pressed. This will make
the clicked scan active, thus redefining the plot "mode".
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21. ChronoSequencing in BatchMode
In BatchMode, it is possible to display the time
scale of the ChronoTechnique methods relative
to the starting time of the Batch. When multiple
techniques are executed in sequence, their time
variable accumulates. This mode is actived by
checking the "ChronoSequencing" checkmark, on
the Batch tabsheet.
Note that if the "cleargraph" option is not used
in batchmode, one can view all the Chrono
results in one plot, in a chronological manner.

22. Working with large datafiles
When experiments produce a large number of datapoints (>10^6), the Windows PC
system can become unstable due to performance issues. In order to ensure reliable
operation with such experiments, IviumSoft employs several strategies. The main
feature is to limit the maximum number of points in memory and visible on screen. Note
that the excess data is not lost, but will be stored on disk. The maximum can be defined
in the "Datahandling options" (see also paragraph 3.3 on p.6):
MWS: The Maximum Workfile Size; default 400,000 points
When an ongoing experiment exceeds MWS, the first halve of the datapoints are saved
to disk in a CSV file, and these are removed from the pc memory (and graph). The visual
plot continues with the most recent datapoints. When the scan continues to produce
data, and the MWS is again exceeded, the first half of the visible data is appended to the
previously created CSV file, and removed from the visual scan. And so on, until the scan
ends.
When such a scan ends, it adds all the remaining data to the CSV file, which will be
saved. Thereafter it will load the complete CSV file, which contains all data points, and
create a reduced datafile, which will be shown and saved in the usual .idf format. The
reduced datafile is designed to contain all important results, while maintaining a
manageable datasize. The reduced datafile characteristics:



Reduced datafiles are always between 15,000 and 200,000 datapoints
For scans that have produced more than 15,000 points, datareduction is
accomplished by omitting datapoints that differ less than 1% from the previous
included point.

Normally a reduced datafile will display all relevant features. However, in case this is in
doubt, the CSV file can be used. This contains the complete datapoint collection. The full
data length can be restored in .idf format by rightclicking the selected scan in the
Legend panel, and pressing "Restore full datasize".
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23. Realtime Impedance
The 'Mixed Mode' technique allows the recording of Impedance data simultaneous with
DC results, in real time. The minimum interval time to allow real time impedance
measurement has been greatly reduced from 0.2 sec to 0.002 sec. But note that at
interval times shorter than 0.2sec, the AC signal is always continuously applied
(regardless of Continuous AC option). At interval times longer than 0.2 sec the AC signal
is only applied at the last portion of the interval.
To make use of real time impedance the the condition must be observed that:
the Signal Frequency must be higher than (2/interval time).
24. ECN: Signal averaging
Normally the signals for each time interval are recorded at the last portion of that
interval: i.e. the signals are sampled at high speed and averaged during a sufficiently
narrow period, that is automatically chosen by the instrument. The option has been
added (in the ECN technique only) to allow the user to override this and redefine the
period by using the "Signal averaging" parameter:

By checking the "Full interval" option, the data is measured and averaged during the
whole interval period (note the similarity with the current integration techniques).
If the "Full interval" option is left unchecked, the user can define the "Averaging time" to
any other value between 0.0003 and 10 seconds. Normally the Averaging time would be
a fraction of the interval time, but it is also possible to use larger time periods. In that
case, the averaging also uses the previous datapoints, and in fact will become a digital
lowpass filter.
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25. ECN analysis: digital low pass filtering
In ECN analysis, an option for digital lowpass filtering has been added:

In the frequency domain a filter function can be applied by checking "Apply". The
frequency and the order can be set by the user. The frequency will correspond with the
cut-off frequency: at which half the signal magnitude is attenuated. The order gives the
"slope" of the filter: 1st order = 20dB/decade, 2nd order=40dB/decade, etc.
26. Power optimization for active Cells.
A new mode has been introduced in the "P-control" of the Mixed Mode technique. This
"P-maximum" -setting facilitates the further investigation and operation of active cells,
such as Batteries, Fuel Cells, SolarCells, and other power generating devices.
The power that a device (Cell) generates is dependent on its Potential/Current settings.
Often there is a certain E/I setpoint that yields maximum Power. That point is not
known in advance and/or is constantly changing, i.e. consider a Solar Cell for which the
incoming light is variable. When the "P maximum" option is checked, IviumSoft will
automatically select the E/I settings that yield maximum power. The Potential/Current
settings are continuously adjusted, so the device is always operated at it maximum
power output.
Note 1:
Note 2:

The P-maximum is software controlled, based on real-time measured values.
The P-maximum point is re-calculated at each 'interval time', so the shorter
the interval, the faster the 'control loop'.
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To operate a cell at maximum power, in Mixed mode technique, Levels, select P control.
In the Properties check "P maximum".
This mode can be used like any other Mixed Mode regime, and can be sequenced at will.
27. Importing Protocol Templates in Mixed Mode (PITT, GITT)
To facilitate the compiling of complex sets of method parameters, it is possible to add
standard protocols. At this time, there are 2 protocols available for Battery testing: GITT
and PITT. Over time, more will be added.
To add a protocol to a Mixed Mode sequence, select the Mixed Mode technique. From the
method parameters, open the Levels window. In the menu bar at the top of this window,
click on 'Add protocol'. This will open an additional pop-up window for selecting and
changing a, predefined, protocol. The protocol parameters can be edited before adding
the protocol to the Mixed Mode. But, after adding the protocol, the lines can also be
edited; they appear as "normal" lines. In this way the protocols can be used as
templates, that are flexible and can be adjusted to any specific requirements.
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28. IviFit - IviumSoft Equivalent Circuit Fitting
The Equivalent Circuit fitting tool, that comes included with IviumSoft, has been greatly
enhanced.
28.1 Increased visual grid
The visual grid has been increased from 5x5 to 8x8 component positions (2564). This
allows for easier building of complex circuits, and it allows even more complex circuits.

28.2 Improved modelling algorithms
The modeling has been optimized in several ways:





The fitting is mathematically more robust, avoiding numerical error messages.
A higher success rate is obtained due to better coping with “local minima”.
Better algorithms are applied to deal with difficult components, such as CPE (Q).

28.3 Automatic generation of startvalues
The modeling tool is now capable of generating its own starting values. This is
convenient for the user, and it obtains better endresults. Therefore by default the
starting values are automatically generated. Optionally, the user can still apply their own
starting values by checking "user defined startvalues".
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28.4 Automatic circuit suggestion
When the equivalent circuit is not known, the Ivium Software can suggest a circuit that
would fit the data the best. This is done by internally evaluating several standard
circuits, and comparing fit quality. At this time only combinations of R,L and C are
included.
28.5 User definable fit boundaries
The user can set boundaries for the fit-able parameters. In the circuit evaluator window
slelect Options/Fitting Options; here the default values for the parameter types, and
their allowable limits, can be set. These will be applied as starting values for newly
created circuit parameters. The boundaries can also be individually edited after circuit
creation in the actual parameter grid.

28.6 Graphic selection of fitting range
The range of data points to be included in (or left out of) the fit can be selected
graphically: simply mouse-click on the outer data points to be included in the fit range.
The fit range is shown in highlight. Only the included (high lighted) datapoints will be
used in the numerical modeling and simulation.
Graphic selection of the fitting range is available in the plots: Bode, Nyquist, RsCs, Y1Y2.
28.7 Kramers Kronig test
Data can be validated by means of the Kramers Kronig test. When you press the
“KKtest” button, the KK plot will be generated.
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28.8 Time response reconstruction from the equivalent circuit
Time responses can be calculated from the equivalent circuit. Equivalent circuits are
normally modeled from the Z vs. frequency relation. However from any equivalent
circuit, the E&I vs. time relation can be reconstructed also. This might be useful for
educational purposes, or verification of particular measurements in the time domain. It
can be selected by clicking the "Time" button. There is a choice between various
potential perturbations: SquareWave, Cosine, Impulse, Sweep, Sine, Step, Triangle.
These perturbations can be applied either in potentiostatic mode (: apply E and measure
I), or in galvanostatatic mode (: apply I and measure E).

For SquareWave, Cosine, Sine and Triangle, also the frequency can be chosen.
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It is possible to transform the axis, evaluate the time dependence of the signals: see the
indicated example above for the linear relation of the Logarithmic decay of the impulse
response on an RC network.
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